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Introduction

Why This Book?

In the beginning, there was After Effects—and it was good (so 
good that a graphics company from California bought it). Once 
inside the Adobe fold, After Effects grew immensely with new 
features and capabilities. The most important in our opinion 
has been integration.

Sure, there are lots of sexy features in After Effects, and we 
love them. But what truly helps us get the job done is that After 
Effects enables us to import graphics files, photos, illustrations, 
and footage, and create compelling animation. These features 
have existed for a long time (layered Adobe Photoshop and 
Adobe Illustrator support has been around for ages).

But Adobe hit upon a true need when it started bundling ap-
plications together. Although the logic has taken a while to seep 
into the pores of designers, there indeed is power in numbers 
when it comes to software. Being able to see After Effects as the 
center point in the Creative Suite empowers a designer to be 
more productive.

A few years back, Rich asked an Adobe exec why he had to use 
Photoshop to bring 3D models into After Effects (instead of 
direct support to just import models). The answer was eye open-
ing. It turns out that designers, medical-imaging professionals, 
and 3D animators all need to use Photoshop. By condensing 
the support for 3D models and formats into one tool, the devel-
opment could be more feature rich. You see, it’s easier to put 
money toward new features to benefit a bigger group of users.

This is why killer features like Dynamic Link exist, for the 
seamless exchange of media between After Effects and Adobe 
Premiere Pro. Photoshop features like Vanishing Point, 3D 
Layers, and Camera Raw can work effortlessly with After Effects. 
The Creative Suite has evolved into a true toolbox; one that has 
a coordinated approach to working seamlessly while getting 
the job done.
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Unfortunately, most After Effects artists are afraid to venture out-
side their comfort zone. For us, a love of Photoshop motivated 
us to explore new ways of making these two applications work 
together. What we found encouraged us and eventually led us to 
Illustrator, Premiere Pro, and Encore. Newer additions like the 
Adobe Media Encoder and Flash also play an important role. 

We’re not advocating for you to go back to school and learn 
every application at the same level that you know After Effects. 
Rather, we offer compelling reasons and practical techniques that 
let you get more from Creative Suite. Whether you use only a few 
applications or want to explore the entire suite, you’ll find time-
saving and inspirational techniques that help you get more done.

Organization of This Book

Motion Graphics with Adobe Creative Suite 5 Studio Techniques is 
organized into three sections:

.	 Section I, “Working Foundations,” discusses the approach 
to modern motion graphics projects. You’ll explore the 
tools contained within the Creative Suite as well as enabling 
technologies like Dynamic Link and the Open in Editor 
command. You’ll also learn how to organize your project for 
cross-application (and even multiplatform) workflows. Don’t 
skip these two chapters, because you’ll learn some core tech-
nology that will save you time and reduce your stress.

.	 Section II, “Design Essentials,” explores the core tasks we 
face as motion graphics artists. You’ll learn how to use ap-
plications like Photoshop, Illustrator, and Adobe Premiere 
Pro to enhance After Effects projects. You’ll also learn about 
new After Effects tools and overlooked commands that are 
truly essential. The whole gamut of tasks is covered, from 
logos, type, and vectors to footage, audio, and 3D.

.	 Section III, “Design Exploration,” examines real-world  
projects and techniques. We often pick up a camera and 
break into the world of production as well. Here you’ll  
investigate new ways to apply your motion graphics knowl-
edge to produce creative output. You’ll find three chapters 
in this section and a bonus chapter on creating a broadcast 
package design for download at www.peachpit.com/mgcs5st.

www.peachpit.com/mgcs5st
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What’s on the DVD?

To see the techniques in the pages come to life, we’ve included 
hands-on projects and source files. Although space limitations 
have meant some compression and trimming, you’ll still find 
completed shots and source materials so you can understand 
how we accomplished the results.

As you read this book, you’ll encounter specific advice and 
techniques. But if you lift the curtain and jump right into the 
project and source files, you’ll see the duct tape and bubble 
gum that holds everything together. We’re not calling our tech-
niques flimsy; rather, we’re guiding you through real-world proj-
ects where nothing is ever perfect. Footage can be poorly shot, 
assets can be lacking, and the like, yet the job still gets done.

We’re results-oriented people. The assets and materials on the 
DVD will show you just how we completed the project. Be sure 
to copy the appropriate folder to your computer’s hard drive 
for each lesson. Due to speed issues and an inability to save your 
progress, you should not work directly off the disc.
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A pessimist sees the difficulty in every opportunity; 
an optimist sees the opportunity in every difficulty.

—Winston Churchill 

Logo Animation

If you’ve been in motion graphics for any amount of 
time, most likely you’ve been asked to animate a logo. 
Often, this is a kind of “right of passage” for young motion 
graphics artists. Unfortunately, so is dealing with not receiv-
ing the most optimum file formats to work with. Even if the 
stars align and we somehow end up with the proper files in 
their preferred format, logos also come with rules. Usually 
supplied by the original logo designer, these rules specify 
how the logo is to appear to best represent its brand. In 
this chapter we’ll examine various workflows to help you 
find those opportunities where others might find difficulty. 

Preparing Your Files 

Where do you start? Do you begin in Adobe Illustrator, 
Adobe Photoshop, or Adobe After Effects? Well, there is 
no right or wrong answer. Each application and file format 
has its own advantages and disadvantages. By the end of 
this chapter, you’ll learn how to move seamlessly between 
these applications and begin to develop your own personal 
animation workflows, no matter where you start.

Logos Have Rules

Whether it’s a large corporation or a small business, ev-
erything from the color to the placement of that logo says 
something about that business. With this knowledge, most 
companies will create a style guide to go along with their 
logo. The style guide is created to ensure that the logo 
will always be used and seen in the best possible light. It 
has a direct impact on what exactly can and can’t be done 
when animating the logo. For example, some style guides 



89

II: Design Essentials

will specify that the logo can only appear on a solid white 
background. Many guides will specify exact color values, 
specific fonts, text placement, and its respective point size. 
Figure 4.1 shows an example of a style guide so you see 
what we mean. 

Figure 4.1  Some style guides are very detailed; others are short and to the point. This is an example of a “one sheet” style 
guide. Smaller guides like this are often found in digital form along with the logo.

Every logo should have a style guide to help define precise-
ly how the logo is to be used. Sadly, we’ve found that most 
style guides only account for print or Web usage. If there 
are no specifications for video, Web specifications are often 
the best place to start for help. They both use RGB color 
space and have lower-resolution requirements.

Should you ever receive a logo without a style guide, the 
Web is a great place to go for guidance. Use the company 
website as a rough reference for placement and usage; that 
way you’ll always have a fallback if questions arise. 

If the logo you’re using has a lot 
of rules and regulations about its 
appearance, it’s always a safe bet 
to animate the background that 
will appear behind a logo rather 
than manipulating the actual logo. 
You can learn more about back-
grounds in Chapter 7, “Designing 
Backgrounds.”



90

Chapter 4	 Logo Animation

Best Files for Animation

When you’re getting ready to animate a logo, some file 
formats are more preferable than others. Unfortunately, all 
too often you’ll end up with a “less-than-preferred” file for-
mat. When this happens, it’s usually time to consider how 
much extra work will be required just to get the logo ready 
for animation. Don’t accept your first dead end as being 
the end of the road. Make a right turn and keep looking 
and asking. Even if you sometimes end up re-creating the 
logo from scratch, we’ve found that double-checking with 
clients will often give them that extra push required to dig 
up a better solution. 

We follow some general rules when it comes to file formats 
for animation. Vector files such as those created from Illus-
trator are always best because they allow you to scale your 
logo up to any size without losing quality (thanks to the 
After Effects Continuously Rasterize option). 

Layered vector files are even better. If each element resides 
on its own layer in Illustrator, you can easily import the 
layered Illustrator file as a composition directly into After 
Effects for animation. Because layers are preserved on im-
port, they are ready for animation. Even if the original logo 
doesn’t have layers, it’s often possible to split the file.

If you can only get a bitmap version of the logo, focus 
on the measurements for width and height, and make 
sure they are least twice the resolution of your final video 
format. For example, when working at a resolution of 
1280x720, we would want a file that’s at least 2560 pixels 
across or 1440 pixels high. This way there is some flexibility 
to scale up the logo in the animation. We often refer to this 
as the “200% rule” for preparing stills for video. Of course 
a layered file would be best, like a PSD or a TIFF for the 
same reasons we mentioned earlier.

Preparing Logos in Illustrator

With its vector tools and ability to customize type using 
OpenType, Illustrator has long been the preferred applica-
tion for designers when creating a logo. It is quite common 
to receive logos as Illustrator files. Usually, preparing these 
files for animation is pretty painless, but here are a few 
gotchas to watch out for.

If you can’t get the client’s logo as 
a vector file, there’s a great website 
to check out. Brands of the World 
(www.BrandsoftheWorld.com) of-
fers several well-known and even 
obscure logos. While you’re there, 
be sure to check out its free font 
section as well.

In Illustrator, sublayers will be 
flattened to their corresponding 
parent layer upon import into After 
Effects. Make sure any separate 
elements live on layers at the top 
of the layer hierarchy. 

Even if a logo file isn’t a native 
Illustrator file, it can easily be con-
verted. Just choose File > Open and 
select a supported vector format 
(like EPS or SVG). You can then split 
the file into layers and save it as an 
Illustrator file.

www.BrandsoftheWorld.com
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Color Space

Because most logos were originally created for use in print 
materials, the files will most likely be in CMYK. And because 
video is RGB, you’ll want to convert any CMYK documents 
to RGB before animation. Converting a file from CMYK to 
RGB is not nearly as problematic as the other way around. 
This is because CMYK has a narrower range of colors, also 
called a gamut. You should see little to no shifting in colors 
when you convert from a CMYK to RGB color space. To 
convert your Illustrator document to RGB, choose File > 
Document Color Mode > RGB Color. To better understand 
how the two spaces overlap, take a look at the color gamut 
chart in Figure 4.2. 

You might find it interesting that RGB and CMYK at their 
core are designed to function quite differently. RGB is an 
additive color model. RGB starts with black (no colors at 
all) as a base color, and as you add more colors, eventu-
ally you will get to white (a mix of all colors) (Figure 4.3). 
CMYK works through subtraction. An image starts with 
white as the background color. As colors are “added,” they 
actually subtract from each other as they mix together. So, 
if you mix all colors in the spectrum together in a CMYK 
document, the result is black (Figure 4.4).

Figure 4.3  Red, green, and blue are 
added together to create white.

Figure 4.4  Cyan, magenta, and yellow 
are subtracted from each other to 
create black.

Figure 4.2  As you can see, RGB 
colors include more colors than CMYK 
except for some very small areas. It’s 
really only when you have a color 
value that’s outside the range of your 
desired color space that you end up 
with a color shift.

When changing color space in 
Illustrator, the colors loaded in the 
swatches palette are determined 
upon document creation and 
will not be converted with your 
document settings. To change color 
space, it is best to copy and paste 
your logo into a new document 
created with any of the Video and 
Film presets.
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Preparing the Artboard

If your document is CMYK, its artboard dimensions are most 
likely also set for print dimensions. Because Illustrator works 
with vectors, converting the artboard to different dimen-
sions doesn’t technically change any of the artwork within 
the document. However, when you start moving that file 
between applications, the artboard dimensions have an im-
pact. For example, when importing a layered Illustrator file 
into After Effects as a composition, the dimensions of the 
composition will be determined by the size of the artboard. 
To change the size of an artboard, choose File > Document 
Setup and click the Edit Artboards button at the top of the 
dialog box (Figure 4.5). However, you’ll find it faster to re-
size the artboard and convert color space by using the copy 
and paste technique we outlined in a previous note.

Figure 4.5  Changing artboards to the 
dimensions of their intended video 
format will help you preview the size 
of the logo in relation to the screen.

We’ll explore using artboards 
in greater depth in Chapter 10, 
“Designing with Vectors.” You’ll 
learn how and when to use mul-
tiple artboards in one Illustrator 
document.
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Release to Layers

If you’re starting with a flattened file in Illustrator, the 
Release To Layers option is a quick way to have Illustra-
tor create layers from the elements that make up the 
logo. You have two options when using Release To Layers 
(Figure 4.6):

.	 Release to Layers (Sequence). Places each object onto 
its own layer.

.	 Release to Layers (Build). Creates a sequential build 
with all the objects, starting with the bottommost object 
on the bottom layer and then duplicating each layer 
and adding objects until the topmost object is added to 
the top layer.

Figure 4.6  On the left, layers are created using Sequence. On the right, layers are created using Build.

Once you’ve released to layers, it’s quite common to end 
up with too many layers. To fix this, you’ll need to group 
layers together by selecting their corresponding targets in 
the Layers panel and pressing Command+G (Ctrl+G). Don’t 
forget to name your layers as you group objects together. A 
random name like “Layer 56” won’t be very helpful when 
animating in After Effects. In addition to the organizational 
benefits, the group command also helps make selecting 
objects in your canvas easier as well (Figure 4.7).

You can quickly create a storyboard 
from your sequential build. Export 
your Illustrator file to Photoshop, 
making sure to select Write Layers. 
Open the newly created Photoshop 
document and choose File > 
Scripts > Export Layers to Files. 
Choose a destination folder and click 
the Run button. With each frame of 
the build saved as an individual file, 
it’s easy to place these frames into a 
storyboard template.
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A B C

Figure 4.7  To quickly select a group in the canvas, use the Selection tool (A). If you want to select one element within that 
group, use the Group Selection tool (B). If you need to select the individual anchor points of an object, use the Direct Selec-
tion tool (C).

Working with Template Layers

You can manually trace over an image by changing its layer 
into a template layer. Usually, we use template layers in Il-
lustrator to allow us to trace more artistic interpretations of 
an image directly overtop of the original image (Figure 4.8). 
Unlike painting in Photoshop, Illustrator creates brush 
strokes with fully editable vector paths. This is amazingly 
helpful when you need to go back and adjust a brush stroke 
that might just be a little off. 

Figure 4.8  Fully editable brush 
strokes created with Artistic Water-
color brushes are traced directly over 
the template layer.
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There are three ways to create a template layer in Illustra-
tor (Figure 4.9): 

.	 When placing an image, select the Template option in 
the pop-up window.

.	 Double-click a layer and select Template.

.	 Choose Template in the Layers menu.

Using template layers in Illustrator is also a great way to create 
extra elements to use in the animation. As motion designers, 
we have the benefit of time (don’t laugh). Even if the anima-
tion needs to end on the original logo, that doesn’t mean we 
can’t play with it along the way. In the Timeline for an anima-
tion, we can cut between treated versions of a logo or just use 
some of the elements to help highlight and add accents to 
different parts of the animation (Figure 4.10). 

 
Figure 4.10  Creating multiple versions of a logo gives you flexibility when it comes time to animate. Just using a simple jump cut  
between the traced and untraced version can spice up the animation without having to use a single keyframe. 

Figure 4.9  It’s always easy to spot a 
template layer because the layer will 
lock, the image will dim its opacity, 
and the eye icon in the Layers panel 
will change. Converting a layer to a 
template layer allows you to trace 
over the layer without worrying about 
accidentally moving the image as 
you work.

Does painting look interesting? 
Don’t worry; we cover Illustrator’s 
extensive paint and drawing tools 
in Chapter 10.  You’ll learn how to 
create realistic brush strokes with 
the Bristle brush; create custom 
brushes; and use the Blob brush, 
Path tool, and erasers, to name just 
a few tools.



96

Chapter 4	 Logo Animation

Live Trace

If you want to create some stylized versions of a bitmap image, 
Live Trace can save you loads of time tracing (Figure 4.11). 
It will automatically trace a bitmap image, creating a vector 
graphic. Several settings control the amount of detail as well 
as the colors used after tracing. 

	1.	 To activate Live Trace, simply place or open a bitmap 
image in Illustrator. When placing an image in Illustra-
tor, the adjustments will appear at the top of the screen 
in the Control panel.

	2.	 Click the arrow button between the Trace button and 
the Mask button, and choose a preset from the list to 
apply your Live Trace.

Live Trace with Layers

Live Trace as a function is very powerful because of its 
presets and ability to quickly deliver some very accurate 
tracings, but sometimes you’ll want more—more detail and 
more control over individual areas of an image. When it 
comes to selecting and isolating specific parts of an image, 
there’s nothing better than Photoshop. So go ahead and 
use Photoshop to separate the different sections of the im-
age onto their own layers.

Figure 4.11  You can create mul-
tiple styles quickly by using the Live 
Trace Presets.

You can have more control over 
Live Trace by selecting the Tracing 
Options at the bottom of the Preset 
list. Use Tracing Options to experi-
ment with multiple settings with 
Preview selected.

We’ll explore the Live Trace com-
mand in greater depth in Chapter 5. 
You’ll learn how to convert a footage 
clip into a vector animation.
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When you’re ready to use Live Trace in Illustrator, choose 
File > Open and select your new layered PSD document. 
Choose Convert Layers to Objects in the Options area 
(Figure 4.12). All the layers are imported just as they were 
in Photoshop. 

 

Preparing Logos in Photoshop

Because video is not vector based, we use Photoshop a lot 
when preparing files for animation. If you’re starting with a 
flattened bitmap image file, Photoshop makes it easy to re-
move the background or separate your logo into multiple 
layers for easy animation. 

Color Space

As discussed earlier in the chapter, RGB color space is very 
important for maintaining color accuracy when creating 
and converting artwork for use in video. If your logo was 
delivered in CMYK, choose Image > Mode > RGB Color to 
convert your file. 

Even if you’re placing an external file into your Photoshop 
document, it’s always wise to make sure that document is 
already converted to RGB before placement.

Figure 4.12  Layered Photoshop files 
work well for import into Illustrator.
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Resolution

As you learned earlier, follow the 200% rule for the best 
resolution results, and be sure to consider the overall pixel 
count determined by pixel height and width. 

Pixel Aspect Ratio

There are so many different dimensions, frame rates, and 
codecs that remembering the exact settings, workflow, 
limitations, and or advantages can get confusing to say 
the least. When you add nonsquare pixels into the mix, 
there’s yet another detail to consider. Using the Film and 
Video project presets found throughout the Creative Suite 
can help lend some organization to the specifics of each 
format. The Creative Suite offers many options that allow 
you to preview nonsquare pixel footage throughout many 
of its applications. 

When we design for large projects, we’ve often found it 
easiest to actually convert any nonsquare pixel footage into a 
square pixel composition so there is one less detail to think 
about. Once everything is square pixel, we no longer have to 
worry about pixels being distorted, interpreted, or displayed 
improperly. Again, because large motion graphics projects 
have so many files moving between various applications, one 
less item to worry about really can make a difference.

Keep in mind that nonsquare pixel assets can be easily 
converted into a corresponding square pixel resolution. 
For example, if you had a project in an Adobe Photoshop 
Extended document that was created with the DVCPRO 
HD 1080p preset (1280x1080 nonsquare pixels), you could 
use one of three ways to convert that to the HDTV 1080p 
preset (1920x1080 square pixels) (Figure 4.13): 

.	 Choose File > Place and place the DVCPRO HD 
1280x1080 footage into a project with correspond-
ing square pixel dimensions, in this case, HDTV 
1920x1080.

.	 Copy and paste the layers between the two projects. 

.	 Drag and drop the layers into the proper project.

Changing the Pixel Aspect Ratio 
of a Photoshop document using 
the View menu does not actually 
change anything in the document. 
This setting only creates a preview 
of what the document will look 
like once the pixels are stretched.
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Figure 4.13  If you use any of the three conversion methods listed, Photoshop will automatically properly resize the footage 
to fit the square canvas settings. To preview a document with nonsquare pixels, choose View > Pixel Aspect Ratio and select 
the desired ratio. Photoshop will then distort the document to simulate its final dimensions.

Removing a Background Using Channels

Consider a typical “worst-case” scenario: Let’s say we have 
clients with time constraints, and the only version of a logo 
they can get us quickly is embedded in a video clip. Before 
Photoshop Extended, we’d usually ask the video editor to 
quickly save out a still frame. Either way, as a still or video 
file, once our logo is open in Photoshop we can separate 
the logo from the background.

With newer tools like the Quick Selection tool and the 
Refine Edge command, separating an object from its back-
ground isn’t nearly the challenge it used to be. However, 
sometimes it might just be faster to use an “old-school” 
technique using channels. Before many of the selection 
tools were created in Photoshop, channels were often the 
easiest and fastest way to select specific areas in an image. 
To view the channels of a Photoshop document, navigate 
to the Channels panel (Figure 4.14).

When you’re using channels, look for the most contrast 
between the logo and the background (Figure 4.15). You 
want to create a selection using the luminance values from 
one of the channels. To have more options for animation, 
don’t worry about keeping the drop shadow as a part of 
the logo. You can always add that back in later.

When you’re trying to view differ-
ent channels in the Channels panel, 
don’t click on the eye icons. Click 
directly on the name of the chan-
nel to view that channel. Be sure to 
activate all the channels again by 
selecting the RGB channel before 
you return to the Layers panel.
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Figure 4.14  Each channel shows the luminance values for each color channel that makes up that image. 

Figure 4.15  The Blue channel looks like a good starting point.

To create a selection from a channel, drag the desired 
channel down to the Layer button in the Channels panel 
to create a duplicate (Figure 4.16). This new copy is now 
an alpha channel. If you were to save this document right 
now, this new alpha channel would control the transpar-
ency for all the channels combined. To be honest, in this 
example it’s hard to see one channel that works better 
than another. Since there is no clear winner, this is the 
perfect time to use more than one channel. Let’s mix it 
up with Calculations!
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Using Calculations to Create Layer Masks

The Calculations command controls how you blend 
together multiple channels. You can even blend together 
the same channel to get various results. Using Calculations 
can save you loads of time when you’re trying to create 
quick selections. You’ll clean up the mask later with the 
new Refine Mask function, so don’t worry about any jagged 
edges or selecting all of the image. You just need to create 
a general selection that’s close. 

	1.	 Convert the background layer into a regular layer by 
double-clicking it in the Layers panel, and then rename 
the layer Logo.

	2.	 With the Logo layer selected, choose Image > Calcula-
tions (Figure 4.17).

The key to success with Calculations is to try and try 
again. Play around with different settings to see where 
they take you. Figure 4.18 shows some of the many set-
tings within Calculations. 

Figure 4.16  Duplicating a channel is 
a good start to making a clean mask. 
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A	 Source. Gives you the ability to blend channels between more 
than one open document.

B	 Layer. Creates the ability to blend between individual layers as 
well as the entire document.

C	 Channel. Specifies exactly which channels to blend between. 
D	 Blending. Controls the specific blending modes happening 

between the above layer and chosen channel settings.
E	 Result. Specifies what format or file to deliver when the Calcula-

tions command has been processed. You can save the blend as a 
new channel, in a brand-new document, or as a selection.

A

B
C

D

E

Figure 4.18  After changing a few options, you have a much better starting point for your mask.

Have fun and change a few settings in the Channel 
areas and the Blending mode options. If you’re using 
the example file from the book, don’t worry about 
specifying layer settings because there is one layer in 
this example. 

	3.	 When you get an outcome that might work, choose 
a setting for your result. For this example, we chose 
Selection.

	4.	 Choose Window > Mask to open the new Masks panel, 
and click the Add Pixel Mask button to apply the selec-
tion as a mask to the layer (Figure 4.19).

Figure 4.17  Although all the options 
may seem a bit overwhelming, it’s 
these options that give Calculations 
its versatility.
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	5.	 Since the mask is masking out the logo, not the back-
ground, click the Invert button in the Masks panel.

Although the result might be close to what you want to 
achieve, you still have some work to do. Let’s clean up the 
mask manually. 

	1.	 To view the grayscale mask you created, Option-click 
(Alt-click) the layer mask thumbnail (Figure 4.20).

Figure 4.20  Viewing the mask is a fast way to see which areas need attention. 

	2.	 To flatten out the variable White and Black levels left in 
the mask, press Command+L (Ctrl+L) to apply a levels 
adjustment (Figure 4.21). Click the black eyedropper 

Figure 4.19  The new Masks panel 
makes working with selections and 
masks a joy.
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tool and click on any gray pixel. Any pixel darker than 
the one you clicked will turn black. Repeat the same 
process using the white eyedropper tool. If you flatten 
out too many of the gray values, you’ll end up with a 
very aliased image. Again, don’t worry about that now; 
you’ll fix it soon using the new Refine Mask command. 

Figure 4.21  The mask after using the black eyedropper tool outside the logo shape to set the black levels. As you can see, it 
helped flatten out the background a lot. 

	3.	 Now that the center of the logo is masked out, just 
paint out any random extra pixels remaining outside 
the logo with the Paint tool. 

Changing Views With Layer Masks

When cleaning up a layer mask, place a solid flat color layer directly below the masked 
layer. Choose a color in direct contrast to the masked layer, and you will see any stray 
pixels that aren’t 100 percent masked out. To view the grayscale mask, Option-click 
(Alt-click) the mask thumbnail. Repeat the key command or just click the layer eye icon 
to redisplay the layers. Shift-click the layer mask to turn it off and display the unmasked 
original layer. Repeat the same process to turn the mask back on.

When applying Calculations 
between different documents, the 
pixel dimensions need to be the 
same. If the documents have two 
different color spaces, you can only 
calculate one channel from the 
source document to blend with the 
composite of the destination docu-
ment. In other words, you cannot 
blend both composite channels 
between two documents that have 
two different color spaces. 
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Finalizing Masks with Refine Mask	

Instead of using blur to fix the rough edges of the mask 
you’ve been working with, you’ll use the new Refine Mask 
function. To activate Refine Mask, click the Mask Edge but-
ton in the Masks panel (Figure 4.22). If you’ve ever found 
pulling a clean mask to be a challenge, this new feature 
should make life much easier. 

Refine Mask actively analyzes the contrasts around the de-
fined edge of a mask to improve detail along the edges of 
a mask. The panel is divided into four distinct sections that 
contain several options (Figure 4.23).

A	 View button. Displays the logo over different backgrounds or the 
original unmasked layer.

B	 Show Original. Toggles the visibility of the layer with the original 
mask applied.

C	 Edge Detection. Controls the width of the edge selection. Use 
a larger number for softer edges and a smaller number for more 
precise edges.

D	 Radius. Toggles the visibility of the edge selection being made by 
Refine Edge. Smart Radius automatically adjusts for sharp and 
soft edges within the selection.

E	 Smooth. Smoothes out any minor irregularities along the edge 
of the selection to remove any jagged edges.

F	 Feather. Softens the transition between the affected and  
unaffected pixels in the selection.

G	 Contrast. Sharpens any soft-edge transitions in the  
selected edge.

H	 Shift Edge. Moves the border of the mask in or out. This is similar 
to choking or expanding a matte when color keying.

I	 Decontaminate Colors. Removes any extraneous color fringing 
along the edge of the mask by changing the color of the edge to 
better match the contained source.

J	 Output To. Determines the format to apply the new refined mask.

A
B

C

J

D

I

E

F

G

H

Figure 4.23  The mask will dynamically update as each  
slider is adjusted.

If you have edges that are soft 
and sharp, select the Smart Radius 
option first.

Figure 4.22  Mask Edge does an 
amazing job of refining edges with 
little or no painting involved.
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Change the View mode to help clarify exactly how the vari-
ous adjustments are affecting the mask. Although an edge 
may seem clean over black, it may show different results 
over white (Figure 4.24). In addition to the slider adjust-
ments, there are four tools within the Refine Mask panel 
(Figure 4.25).

A

B
C

A	 Zoom and Hand tools. Function  
exactly like the corresponding tools in 
the Photoshop Tools panel, controlling 
magnification and navigation around 
the canvas.

B	 Refine Radius tool. Allows for precise 
control in defining edges through paint-
ing directly on the canvas.

C	 Remove Refine Mask tool. Provides 
paintable control for removing areas 
affected by the Refine Mask function.

Figure 4.24  Use the key commands 
listed to the right of each name to 
quickly change between View modes.

Figure 4.25  The Refine Radius and 
Remove Refine Mask tools help refine 
the selection of the edge being af-
fected by the Refine Edge command.
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Figure 4.26 shows how we fixed the aliasing on the original 
matte using Refine Mask. Consider the following tips when 
using this function:

.	 Only use Smart Radius if you have irregular edges that 
transition from smooth to sharp to smooth again. 

.	 Wait to paint. Make sure all the sliders are first set to 0. 
Start by adjusting the Radius slider, and then move on 
to the other sliders. 

.	 Use the Refine Radius and Remove Refine Mask tools 
to further refine the mask with more precise control. 
Be as accurate as possible with the placement of your 
brush as you paint. If you need to make a minor fix, 
start painting away from the area and slowly move the 
brush back toward the area to watch the adjustments. 

.	 If you want to compare the original mask with the 
refined mask, choose one of the New Layer options 
in the Output To menu when you’ve finished your 
adjustments.

File Formats in Practice

When creating graphics for use in a film or broadcast, 
it’s quite common to have to deliver graphic elements 
to an editor for final placement into the project. Most 
editing systems natively support layered Photoshop docu-
ments, but some may not. If the editor is working outside 
an Adobe workflow, two of the more popular and widely 

Figure 4.26  After some trial and error, 
the Refine Mask command has really 
helped smooth out the mask.
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supported formats for still graphics are TIFF and TARGA. 
Because they are uncompressed by default and also sup-
port alpha channels for transparency, they are a good 
choice for graphics.

Manually Creating Alpha Channels

Saving a TIFF or TARGA file out of Photoshop is a straight-
forward process. But if you want a graphic to have transpar-
ency, you need to save that transparency information as an 
alpha channel. Here’s a quick shortcut: Command-click 
(Ctrl-click) on the thumbnail of a layer to load any painted 
pixels as a selection (Figure 4.27). If you want to add more 
than one layer’s information, hold down Command+Shift 
(Ctrl+Shift) as you click on more thumbnails in the 
Layers panel. 

Figure 4.27  Once you’re comfortable using Command-click (Ctrl-click) for quick 
selections, don’t be surprised at just how often you’ll use it.

To save the selection as an alpha channel, choose Select > 
Save Selection and click OK. With the transparency saved 
as an alpha channel, the document is ready to save as a 
flattened TIFF or TARGA file while still preserving the 
transparency. 

Preparing for Animation

Layers are as essential to motion graphics as letters are to 
the written word. So, just like each letter has a purpose in 
composing a word, each layer should have a purpose in 
your compositions as well. When brainstorming about logo 

When using Command-click 
(Ctrl-click) to select transparent 
pixels, watch out for layer styles 
and Repoussé. Both need to be 
rasterized before their effects can 
be loaded as part of a transparency 
selection. Be sure to save another 
copy of the layer or document 
since these effects will no longer 
be editable. To rasterize layer styles 
or Repoussé, create a new blank 
layer, select both the new layer 
and the layer containing the layer 
styles (or Repoussé), and press 
Command+E (Ctrl+E) to merge 
the layers together. Then you can 
Command-click (Ctrl-click) on the 
thumbnail of the layer to load the 
transparency data. 

To quickly and easily create a 
flattened file with an alpha chan-
nel, load the preset video actions 
in the Actions panel. The Alpha 
Channel from Transparency action 
will properly load all transpar-
ency, including any layer styles or 
Repoussé information, and create 
the proper alpha channel data.
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animation, it’s always a good idea to start with some solid 
basics. The animation of a logo can be just as much of a 
brand mark as the still logo. Always try to ensure that the 
animation stays true to the brand.

Importing Logos into After Effects

There are three main ways to import files into After Effects 
(Figure 4.28). Which one you choose really depends on 
the sources you have at hand:

.	 Project files. If you’ve already animated a logo, you 
can import one After Effects project into another. This 
will bring all the compositions and sources into your 
current project. This workflow is best if you have some 
standard elements that you need to reuse from project 
to project.

.	 Composition. If your source is a layered Photoshop or 
Illustrator file, you’re in luck. Someone worked hard to 
create all those layers, so preserve them. Layered files 
can and should be imported as compositions.

Figure 4.28  Each of these three 
import options is designed to help 
speed up the animation process when 
importing layered Photoshop and 
Illustrator documents.
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.	 Footage. If you’re in a hurry or are dealing with flat-
tened sources, your choices are pretty limited. Any 
graphic you import into After Effects can be imported 
as footage. This is the most common option if your logo 
is a flattened graphic or a prerendered movie file with 
an alpha channel.

Let’s explore the options you have when working with com-
positions or footage import.

Compositions

When importing a layered document for animation, 
choose Composition – Retain Layer Size. This makes 
animation faster because each layer is individually sized, 
and its anchor point is placed at the center of each layer as 
opposed to the center of the composition. With the anchor 
point already set to the center of each layer, transform 
properties like scale, position, and rotate will function 
as expected, centered on each layer. Importing layered 
Photoshop and Illustrator files as compositions is a great 
time-saver and results in a smooth workflow. 

Footage

Anytime you import graphics or video into After Effects 
you’re creating footage. Even when you import a layered 
Photoshop or Illustrator file as a composition, each layer 
that was imported is considered to be footage. To look at 
the specific properties of any footage item in After Effects, 
just select the footage item in the Project panel and look 
at the text to the right of the preview thumbnail at the top 
of the panel. You can find out more information if you 
Option-click (Alt-click) directly on the footage item. 

It’s sometimes necessary to change how After Effects in-
terprets footage, such as to specify how the alpha channel 
or frame rate should be handled. To access the Interpret 
Footage dialog box, select the footage and choose File > 
Interpret Footage > Main (Figure 4.29). 

When modifying footage in the 
Interpret Footage dialog box, you 
may notice that some of the fields 
are grayed out. Don’t panic; that 
just means that the selected foot-
age didn’t have those properties to 
change in the first place.
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Since most motion graphics projects end up with a range 
of footage sources (to say the least), it’s a good idea to be 
meticulous about organization. So if you haven’t checked 
out Chapter 1, we covered several techniques for dealing 
with footage and keeping your projects organized while 
working in After Effects. 

Interpreting Alpha Channels

Alpha channel information can be stored with color chan-
nels in two ways: straight and premultiplied. Whenever any 
footage with transparency is imported into After Effects, 
alpha channel data is being interpreted. For example, if 
you select any Photoshop footage in the Project panel, 
you’ll see the words Millions of Colors + (Straight). The + 
denotes an alpha channel is present, and (Straight) means 
the footage has color channels that do not include infor-
mation related to the alpha channel. Photoshop works with 
straight channels because they have the best color accura-
cy. Premultiplied channels are most common when dealing 

Figure 4.29  In the Main Options tab 
of the dialog box you can change the 
settings for the alpha channel, field or-
der, frame rates, and pixel aspect ratio. 
If you’re being plagued by strange ren-
der issues with certain shots, Interpret 
Footage is always a good place to start 
your troubleshooting process.

If you’re not quite sure what kind 
of channels you’re dealing with, 
you can have After Effects guess 
for you as it analyzes the file on 
import. Just press the Guess button 
toward the top of the Interpret 
Footage dialog box.
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with moving graphics. Adobe Premiere and After Effects 
support both kinds of channels. 

If you ever notice a strange “halo” effect around your graph-
ics, it’s most likely due to how the alpha channel was inter-
preted. To fix this, just access the Interpret Footage dialog 
box and change the channel interpretation (Figure 4.30). 

Converting Photoshop Text to Vector Type

One of our favorite integration features between Photo-
shop and After Effects is editable text. Any editable text in 
Photoshop that is imported into After Effects can actually 
be converted into editable text in After Effects. Although 
this doesn’t happen by default, it’s an amazingly helpful 
feature. In the Timeline, just select any layers that were 
text in Photoshop and choose Layer > Convert To Editable 
Text. Now the text is exactly the same as it would be if you 
created it directly in After Effects. 

Why should you convert your text in After Effects? Well, it’s 
worth it! You can scale the text infinitely. You can also take 
advantage of the text animation controls in After Effects. 
We explore text animation more in Chapter 3, “Typogra-
phy for the Screen.”

Using Continuously Rasterize

Continuous rasterization is applied when the Continu-
ously Rasterize switch is selected on a vector graphic layer 
(Figure 4.31). This allows a vector graphic to scale without 
pixelation. Using continuous rasterization does increase 
render time because the graphic is continuously redrawn 

Figure 4.30  In addition to changing 
the interpretation, if you’re getting a 
strange fringe color, you can use the 
eyedropper to sample the specific 
color and clean up that edge.
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using the vector data. When you scale a vector logo over 
100 percent and want to prevent the image from pixelat-
ing, using continuous rasterization is a must.

Figure 4.31  You can select or deselect Continuously Rasterize for each vector layer and choose exactly which layers need 
to remain sharp when scaling up to 100 percent.

Continuously Rasterize, Behind the Scenes

Toggling the Continuously Rasterize switch changes the render order of the  
composition. How the effects and masks are processed will occur in a different  
order depending on whether Continuously Rasterize is on or off.
	 If you’re dealing with a standard layer or the Continuously Rasterize option is 
deselected, your composition will process as follows:

1.	 Masks
2.	 Effects
3. 	 Transformations

	 If you select the Continuously Rasterize option, the render order changes to:
1.	 Transformations
2.	 Masks
3.	 Effects

	 The Continuously Rasterize option can be a little confusing in that it actually can 
perform two functions. If selected on a layer that is a nested composition, the option 
will collapse transformations. 
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Logo Animation Techniques

Now, let’s explore some additional techniques that we use 
most when it comes to animating a logo. We provide some 
step-by-step instruction, but the information we offer is 
more of a broad overview of ideas meant to motivate you. 

Even if you have perfectly prepped source files, animating 
logos can be a little complicated. Not only do you need to 
find inspiration, but you’ll also need to determine just how 
much creative latitude you have to manipulate the logo. 
The more you find out at the beginning of a project, the 
less heartache at the end.

Because almost all art is created through inspiration, many 
of the techniques we discuss are based on finding insight 
through the unique properties of each logo. And because 
a logo is an iconic representation of a brand, it’s important 
to consider that as well. 

Using Audio for Inspiration

If you ever get stuck with a logo or graphic that just doesn’t 
excite you, audio is always a great place to turn. Ask your 
client for any other collateral marketing materials. Even if 
the client doesn’t have any audio or video materials, use 
what you know about the brand to find something on your 
own. Adding audio to even the smallest animation will go 
a long way when it comes time to present that animation. 
As you’re listening to various tracks of music, visualize your 
animation playing out to the key points in the music track.

If you need to find the music on your own, Adobe Sound-
booth is a great place to start. In Soundbooth you’ll find a 
large amount of royalty-free audio to use in your projects. 
We cover Soundbooth more in depth in Chapter 9, “De-
signing with Audio.” Let’s return to the process of anima-
tion once you’ve found the right audio soundtrack. 

To time key points of your animation with key points in 
the audio, you’ll need to use markers. Markers will trans-
late across applications in Creative Suite 5. When you add 
markers in Premiere or Soundbooth, they’ll import into 
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After Effects either through import or Dynamic Link. 
Markers offer easy points to synchronize reveals for dif-
ferent pieces of a logo. After all, you’d like your logo to 
time out to the music or sound effects track whenever 
possible. We typically try to mark audio using applications 
like Soundbooth or Premiere Pro, but if you need to cre-
ate markers directly within After Effects, there are several 
ways to do so.

To time an animation to audio, start with just the audio 
file first. To ensure that the audio is playing in realtime, 
load an audio only preview by pressing the . (decimal) key 
on your keypad instead of a RAM preview. As the audio 
preview is playing, you can add layer markers or composi-
tion markers into your projects. We recommend adding an 
adjustment or solid layer to hold just the markers or add 
them directly to the audio track. 

To create a layer marker, select the layer you want to mark 
and press the * (multiply) key on your keypad (Ctrl+8 on a 
Mac if you don’t have a keypad). The marker will be added 
to the selected layer wherever your current time indicator 
is in the Timeline. For best results, invoke an audio preview 
and literally “tap out” the beat you want. If you need to 
remove a marker, you can right-click and delete it. Check 
out the files in the Chapter_04_Media folder included on 
the DVD to see just how useful the audio and markers were 
to create the ECO logo animation.

Gaining Control with Hierarchy

When you have audio for your project, it’s time to use the 
elements that make up the logo for further inspiration. 
Having a layered Illustrator file is essential, but once all 
those layers are imported into After Effects, you’ll have to 
deal with a whole new set of challenges. Using the ECO 
logo animation as an example, as you spin one circle, 
you’ll want the other circles to move interactively. To make 
animating all these layers effortless, you need to create a 
hierarchy among the circles (Figure 4.32).

If you’re not getting enough of a 
preview, you do have options. You 
can change the duration of audio 
previews in Preferences. Open the 
After Effects Preferences window 
by choosing After Effects > 
Preferences > Previews (Edit > 
Preferences > Previews). Enter 
a longer duration into the Audio 
Preview field. 

Figure 4.32  The intertwined circles 
in this logo are screaming for some 
kind of animation where they can spin 
around and “interact” with each other. 
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Parenting Layers

If you’ve ever experimented with character animation, you’ve 
probably heard of the term rigging. For example, if you 
rotated the arm on a rigged character, the chain of animation 
would make the forearm, hand, wrist, and fingers follow the 
position of the rotation. In After Effects, the primary steps 
for rigging are achieved through parenting the layers (Fig-
ure 4.33). You could also use Expressions for extra control 
between parameters, but for now let’s stick to parenting.

Figure 4.33  Even though there are multiple levels of parenting, you can always clearly see the exact details by looking in the Parent 
column.

If the Parent column is not available along the top of your 
Timeline, right-click (Control-click) next to the word 
Source Name, select Columns, then select Parent from the 
list that appears (Figure 4.34) to show the Parent column. 
There are two ways to parent layers in After Effects:

Figure 4.34  In addition to activating the Parent column, you can activate a host of other columns via the same key command.
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.	 Select the layer you want to be the parent layer and click 
the menu in the Parent section of the Timeline panel. 
Choose the layer you want to control. That layer is now 
known as the child of the parent layer (Figure 4.35).

Menu

Pick Whip

Figure 4.35  It’s rather straightforward to assign the parent/child relationship using either the menu or the pick whip.

.	 Drag the pick whip for the parent layer to the layer 
name of the child layer. When the name is highlighted, 
let go of the pick whip. The child layer name should 
now appear in the parent layer, just like when you 
chose it from the list (Figure 4.35). 

Null Objects

When you have to move a number of layers around a scene 
simultaneously, you can select all the layers and choose 
Layer > Pre-Compose. If you need to have access to all 
those individual elements, as well as every other layer in 
the composition, you’ll want to create a null object. To cre-
ate a null object, choose Layer > New > Null Object. With 
a null object, you can take all those layers you need to ani-
mate together and make them children of the null object. 
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Then you can apply your keyframes to the null object just 
like a pre-comp. Just remember that null objects do not 
control opacity. Anytime you think you might need a bit 
more control over the elements onscreen, a null object is 
always a good place to start.

Finishing Touches with Adjustment Layers

More often than not, logos end up looking a little flat. 
It’s just the nature of optimizing an icon to look good on 
anything from print to an iPod to a king-size home the-
ater system. Here is where adjustment layers come to the 
rescue. You can apply an effect directly to the adjustment 
layer, and that effect will treat any layer that is below the 
adjustment layer in the composition (Figure 4.36). Howev-
er, when you’re working with iconic logos that have sharp 
edges and clean lines, it’s very important to get the anima-
tion pixel perfect. Then take some time to look at some 
different ways to treat the footage. 

Figure 4.36  The filters applied to the adjustment layers add depth and style to the logo animation.

To create an adjustment layer, choose Layer > New > Adjust-
ment Layer. In the ECO logo animation, we used adjustment 
layers to apply the finishing flares, blurs, and color correc-
tions. To draw attention to the center of the screen, we ap-
plied a blur and vignette to the edges of the canvas, masking 
out the center of the adjustment layer. To add some pop to 
the open, we used the CC Light Burst 2.5 effect to create the 
flash/glow at the beginning of the animation. 

To only apply effects to certain 
areas, use a mask directly on the 
adjustment layer.
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You can even use adjustment layers with the Generate 
effects like Circle. Because the logo was so circular in 
animation, we wanted circular “rays of light” to fly out from 
behind the main part of the logo at key audio points. They 
were often pretty subtle, but it’s those little things that can 
make or break an animation. 

Check out the project files and QuickTime movie included 
on the accompanying DVD if you want a closer look at the 
ECO logo animation project.
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A
AAC (Advanced Audio Codec) format, 261
actions, storing in Photoshop, 381
adjustment layers. See also layers

keyboard shortcut, 134
using in Photoshop Extended, 127–128
using with logo animations, 118–119

Adobe Bridge CS5. See Bridge CS5
Adobe Media Encoder

automatic file conversion, 261
features of, 10
moving files in, 23

Adobe OnLocation CS5, 8–9, 20, 23
Adobe Premiere Pro CS5. See Premiere Pro CS5
Adobe Sound (ASND) audio format, 8, 261
After Effects

animating 3D space with, 350–356
animating in, 204–207
audio formats recognized by, 8
built-in backgrounds, 200
cloning objects in, 163–167
Compositions option for animation, 110
creating motion with, 208–212
creating shapes in, 215
creating type on path, 85
customizing music and scores for, 8
determining channel types, 111
examining presets, 37
exporting assets to, 19
Extrude & Bevel command, 228
Footage option for animation, 110–111
gradient maps, 134–136
importing 3D objects into, 246–248
importing footage formats, 16–17
importing footage into, 149–150
importing layered sources in, 34
importing logos into, 109–111
lighting scenes for panoramas, 391–392
modifying velocity curves for keyframes, 340–341
moving files in, 23
panoramic photos in, 386–392
placing photos into compositions, 337
prepping layered documents for, 349–350
preprocessing footage, 145–146
presets, 143–144
previewing audio in, 264–265
rare use of audio capabilities, 5
resetting views and cameras in, 222
Revolve command, 228
Rotate command, 228
scripts for panoramas, 387–389
seamless loops for panoramas, 386–387
sharpening effects, 332
supported file types, 14

2D and 3D layers, layering, 227–228
2D motion control, creating, 329
2.5D, working in, 223
3D

converting objects to, 222
creating with Repoussé, 80–82

3D cameras
animating, 354–356
integrating panoramas with, 389–391

3D content
isolating effects for, 226–227
rendering, 225

3D effects, updating, 230
3D elements, adjusting, 243–244
3D files

formats in Photoshop, 240–241
importing, 224–225

3D in After Effects
active cameras switching, 251–252
camera presets, 250–251
controlling cameras with null objects, 253–254
creating rack focus effects, 252
depth of field, 252–253
effect cameras, 252
Focus Distance, 252–253
moving layers in Z space, 251
multiple views, 249–250
parenting lights, 254
posing subjects, 251
switching preview resolution, 249

3D layers
changing viewpoints of, 248–249
creating in Photoshop, 232

3D materials, resource for, 239
3D models. See also models

finding, 243
importing, 241–243
integrating, 328
switching to 3D layers, 248

3D objects
applying artwork to, 229
boosting memory for, 245
importing into After Effects, 246–248
modifying lights for, 247
modifying textures for, 247

3D Postcard, creating in Photoshop, 232–233
3D shapes, creating in Photoshop, 233–234
3D sources, managing RAM for, 248
3D space

animating with After Effects, 350–356
converting Photoshop files to, 351–352
working in, 328

3D text, creating with Repoussé, 236–239
4-Color Gradient effect, using, 193–194
24p material, converting frame rate of, 181
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After Effects (continued)
Text tool, 83–85
Time Remapping effect, 184
using Flash Video files with, 16
using shape layers in, 313
vector tools, 288
virtual sets for panoramas, 387–389
working in 3D, 224–227
working with MXF formats, 16

After Effects and Flash, exchanging projects 
between, 22

After Effects compositions, exporting, 21–22
After Effects projects

collecting files, 46–48
importing folders, 39
internal folder organization, 39–40
placeholders, 42–43
proxies, 43–44
reducing, 46
removing unused footage, 44–45
renaming assets, 40–41
swapping asset, 41–42

After Effects vector elements. See also vectors
custom animation paths, 314–315
generating path effects, 318–322
importing artboards, 316
importing vector shapes and paths, 317–318
morphing shapes, 315–316
Shape Layers, 313

AIFF (Audio Interchange File Format), 261
Align buttons, using, 66–67
alpha channels

creating flattened files with, 108
creating manually, 108
fixing halo effects, 112
interpreting for logo animation, 111–112

ambient light, using, 363
anchor points

changing for layers, 36
moving, 77
using with photos, 336

animating in After Effects, 204–207
animation. See also graphic-texture animation; logo 

animation
organizing layers for, 307
setting type path for, 79
stop-motion style of, 9

animation paths, customizing in After Effects, 
314–315

animation properties, using with photos, 336
anti-aliasing, setting for typefaces, 66
artboards

importing into After Effects, 316
for logos in Illustrator, 92
using with vector documents, 293–294

ASND (Adobe Sound) audio format, 8, 261
assets

renaming, 40–41
swapping, 41–42

audio. See also expressions with audio; graphics and 
audio; Soundbooth CS5

converting to keyframes, 271–272
creating from Tone effect, 269–270
importing into Soundbooth, 278
previewing in After Effects, 264–265
previewing in specific range, 264
timing animations to, 115
using Soundbooth CS5 for, 7–8

Audio Interchange File Format (AIFF), 261
audio sources

bit depth, 262
file formats, 260–261
sample rate conversions, 262–263
sample rates, 262

Audio Sources folder, using, 29
Audio Spectrum effect, using, 267–268
audio sync points

adding markers, 265–266
adding Soundbooth to workflow, 266
previewing in After Effects, 264–265

audio tracks, converting to After Effects, 19
audio transitions, converting to After Effects, 19
Audio Waveform effect, 268–269
authoring tools, 9
Auto effects, making quick fixes with, 160–162
Avid, importing files from, 18–19

B
background plate, getting, 349
backgrounds. See also media backgrounds in After 

Effects
browsing with Adobe Bridge, 200
designing with Brainstorm, 213–214
in After Effects, 200
gathering sources for, 191–192
looping, 192–193, 211–212
removing, 349
role of, 191
separating foreground objects from, 173–179
separating objects from, 99

baseline of type
explained, 56
setting, 66

batch process, using with Photoshop, 129
Beam effects, generating in After Effects, 320–321
Bedford: The Town They Left Behind

approach, 327–329
described, 326

Berlin, Elliot, 326
bevel effects, creating, 229–230
bit depth, considering for audio, 262
Black & White adjustment, 131–132
blemishes, removing from images, 383
Blend tool, using in Illustrator, 296–297
blending modes

converting to After Effects, 19
learning for media backgrounds, 415

blinking lights project, 186–188
Blob brushes, using in Illustrator, 303–304
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Blue-ray formats, using with menus, 416
Blu-ray design. See also Encore menus; footage 

plates for menus; Premiere Pro footage
building design brief, 395–396
creating flowcharts, 398–399
identifying connections, 398–399
organizing assets with Bridge, 396–398
organizing projects, 396

Box Blur effect, 141, 146
Brainstorm, using to design backgrounds, 213–214
Bridge CS5

browsing backgrounds with, 200
features of, 8
invoking Photomerge command from, 376–377
organizing Blu-ray and DVD assets with, 396–398
processing footage with, 148–149
using to organize files, 37–38

brightness, adjusting, 171
Bristle brushes, using in Illustrator, 301–303
brushes

Healing Brush 168, 384–385
Roto Brush, 173–179
Spot Healing Brush, 168, 385

brushes in Illustrator
Blob brush, 303–304
Bristle, 301–303

Brushes panel, using with Clone Stamp tool, 164
button naming styles for menus, 427

C
Calculations command

in Photoshop for logos, 101–104
using with keying, 169

camera moves
creating arced, 356
planning, 343

Camera Rotate tool, using with 3D elements, 244
cameras

choosing for Blu-ray and DVD design, 405–406
resetting in After Affects, 222

Capture Scratch folder, using, 28
cartoon look, creating with Live Trace, 145
CC Kaleida effect, using, 218
Cell Pattern effect, using, 194–196. See also patterns
Channel Blur effect, using, 171
channel type, determining in After Effects, 111
Channel Volume audio filters, converting to After 

Effects, 19
channels

blending for logos in Photoshop, 101–104
using to remove logo backgrounds, 99–101

Character panel. See also fonts; text; typefaces
choosing typefaces from, 57
controls, 66

characters, limitations for naming files, 33
clip marker, converting to After Effects, 19
clips

changing rates of, 180
conforming, 180–181

importing from OnLocation projects, 20
importing sequences as, 20–21

Clone Stamp tool
using, 164, 332
using with panoramic photos, 383–384
using with photos for motion control, 332–333

cloning
advanced in Photoshop, 167–168
making room for, 164–165
offsetting across time, 165

cloning area, previewing, 166
CMYK documents, converting to RGB, 91, 97
Collect Files command, using, 46–48
color

creating matte from, 170–173
fixing via Auto effects, 161
setting for type, 66
suppressing in noise, 155

color cast, removing, 154
color grading

black and white conversion, 131–133
curves, 139
duotones, 133
gradient maps, 133–138
On Image tool, 132–133
Leave Color effect, 139–140
Photo Filter adjustment, 130–131

color mattes, converting to After Effects, 19
Color Range command, using, 345
color space

for logos in Illustrator, 91
for logos in Photoshop, 97

color temperature, adjusting, 130–131
colorizing grayscale textures, 199
Common Media Folders

customizing, 30
reasons for use of, 27–28
saving to, 30–31
setting up, 28–29
structure of, 28–29
targeting, 30–32
using to save hard drive space, 30

composition markers, using with audio, 265
compositions

fitting layers to, 36–37
placing photos into, 337

Content-Aware Fill
using with panoramic photos, 382–383
using with photos for motion control, 333–334

Content-Aware Scale, using with photos for motion 
control, 334–335

Continuously Rasterize option, 112–113. See also 
raster graphics

contrast
fixing via Auto effects, 161
restoring, 154–155

Convert Point tool
using, 77
using in Illustrator, 295

Convolution Reverb effect, using in Soundbooth, 282
corner points, creating, 290
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Creative Suite
moving media in, 23
using to improve workflow, 10–13

crop filters, converting to After Effects, 19
curves, producing meshes with, 235
Curves feature, using in Photoshop, 139
cycs, using in Blu-ray and DVD design, 401

D
depth, creating with particles, 365
Device Central CS5, 9–10, 12–13
Direct Selection tool

using in Photoshop, 79
using with paths and points, 289

directional light, using, 363
drive system, sharing, 28
duotones, creating, 133
duplicate footage, removing, 45
DVD design. See also Encore menus; footage 

plates for menus; Photoshop DVD menu design; 
Premiere Pro footage

building design brief, 395–396
creating flowcharts, 398–399
identifying connections, 398–399
organizing assets with Bridge, 396–398
organizing projects, 396

Dynamic Link
After Effects to other applications, 21–22
Premiere Pro to After Effects, 20–21

E
Ebberts, Dan, 273
Edit Original command, using to update graphic 

files, 15
editable layer styles, displaying in Timeline panel, 81
effects

4-Color Gradient, 193–194
CC Kaleida, 218
Cell Pattern, 194–196
Convolution Reverb, 282
Fractal Noise, 198–199
ID Matte, 226–227
Live Photoshop 3D, 247
Radio Waves, 196–198
Tone, 269–270
Turbulent Noise, 199
updating 3D, 230

Encore CS5
features of, 9
moving files in, 23
using in Blu-ray and DVD design, 394, 422–423, 

425–431
Encore menus. See also Blu-ray design; DVD design; 

menus
adding backgrounds, 429–430
importing assets, 428–429
previewing motion menus, 431
setting button order, 430–431

Equalize effect, using to balance images, 170

Exponential Scale, changing effects of, 340
exposure, controlling, 162–163
expressions with audio. See also audio

converting audio to keyframes, 271
finding, 273
shortcuts for, 273
websites, 273

Extrude & Bevel command, using in Illustrator, 
228–230

F
Fab, Joe, 326
filename characters, illegal, 33
files

collecting, 46–48
deleting from Project panel, 40
importing multiple, 39
moving in Production Premium, 23
naming, 32–33
organizing with Adobe Bridge, 37–38

fill pixels, using in Photoshop, 310. See also pixels
film-look effect, creating, 141
filters, using in Photoshop, 332
Final Cut Pro, importing files from, 18–19
Final Exported Files folder, using, 29
Flash

moving files in, 23
vector tools in, 288

Flash and After Effects, exchanging projects 
between, 22

Flash Catalyst CS5, 9
Flash Interactive format, using with menus, 416
Flash Professional CS5, 7
Flash Video files, working with, 16
flicker, fixing in images, 340
folder structure, creating zipped copy of, 30
folders

adding, 39–40
deleting from Project panel, 40
importing, 39
naming, 32–33
removing, 39–40
selecting items in, 40
using, 39–40

font families, 57–58
font technology. See also typographic controls

OpenType, 54
PostScript, 53
TrueType, 53

fonts. See also text; typefaces
“faux” settings, 59
selecting, 57
versus typefaces, 54–56, 58

footage
converting to vectors, 144–150
importing into After Effects, 149–150
organizing, 18
preprocessing with After Effects, 145–146
processing with Adobe Bridge, 148–149
processing with Illustrator, 146–147
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removing unused, 44–45
replacing, 34, 41–42
resampling, 181–183
scaling horizontally, 36
scaling vertically, 36
stabilizing, 157–160
using proxies with, 43–44

footage files, working with, 16–18
footage items, removing duplicates of, 45
footage plates

liquid pours, 408–409
moving lights, 411
perpendicular shots, 409–410
shooting advice, 407–408
spinning shots, 410–411
using, 364–365

footage plates for menus. See also Blu-ray design; 
DVD design; menus

choosing cameras, 404–405
creating studio, 400–401
cycs, 401
finding objects, 405–406
gels, 403
lighting equipment, 402–403
monitors, 405
motorized turntable, 401
tripods, 405
using HD, 404

footage plates, using for backgrounds, 191
footage repair. See repairing footage
footage retiming

frame rate conversion, 180–183
time ramapping, 184–186

foreground object, separating from background, 
173–179

Fractal Noise effect, using, 198–199. See also noise
Frame Hold, converting to After Effects, 19
frame rate, converting, 181–183

G
gels, using in Blu-ray and DVD design, 403
Glyph Scaling option, 68
gradient maps

using, 133–134
using in After Effects, 134–136
using in Photoshop, 136–138

grain, cleaning up, 155–156
grain and noise, removing, 154–156
Graph Editor, using with Time Remapping, 185–186
graphic files

supported types of, 14
updating, 15
updating with alpha channels, 15

graphic formats
TARGA, 108
TIFF, 108

Graphic Renders folder, using, 29
Graphic Sources folder, using, 29
graphics, creating variations of, 294
graphics and audio. See also audio

Audio Spectrum effect, 267–268
Audio Waveform effect, 268
using tone to create sound, 269–270

graphic-texture animation. See also animation
creating motion with After Effects, 208–212
in After Effects, 204–207
Offset technique, 201–204
stitch in time technique, 207–208

grayscale mask, viewing for logo, 103
grayscale meshes, creating in Photoshop, 234–235
grayscale textures, colorizing, 199. See also textures
green screen footage, use of, 168
grids, creating in Illustrator, 297–299

H
halo effect, fixing for alpha channels, 112
hanging punctuation, placing, 71
hard drive space, saving, 30
HD, designing for, 404, 416
HDSLR cameras, using with Blu-ray and DVDs, 404
Healing Brush tool

using with logos in clothing, 168
using with panoramic photos, 384–385

hyphens, applying, 68–70

I
ID Matte effect, using with 3D content, 226–227
Illustrator CS5

accessing controls in, 295
Appearance panel, 295
bevel presets, 229
changing size of text area, 71
changing workspaces in, 291
color space for logos, 91
Convert Point tool, 295
converting type to outlines, 76–77
creating custom type, 76–77
creating variations on shapes, 300
creating versions of logos, 95–97
expanding blends, 308
features of, 6
importing type, 71–72
Live Paint Bucket tool, 298–299
Live Trace for logos, 95–97
moving files in, 23
pasting paths into After Effects, 296
point and paragraph controls, 73
processing footage with, 146–147
Release to Layers for logos, 93–94
sections of effects in, 299
setting type along path, 74–76
Shape Builder tool, 306
specifying columns for type, 73
specifying rows for type, 73
Spiral tool, 294
switching type orientation, 73
template layers for logos, 94–95
tracing over images in, 94–95
typographic controls in, 63



438

Index

Illustrator CS5 (continued)
using Pathfinder to create shapes, 305–306
using symbols for quick designs, 307
vector tools in, 287
Width tool, 295
wrapping type around objects, 74–76

Illustrator effects for adding depth
Extrude & Bevel command, 229–230
Revolve command, 230–231

Illustrator files, creating for vector documents, 
292–293

Illustrator’s vector tools. See also vectors
adding textures, 300–304
Blend, 296–297
brushes, 300–304
building complex shapes, 304–306
creating flowing lines, 296–297
creating fluid shapes, 294–296
creating grids, 297–299
creating libraries of shapes, 306–307
expanding objects, 308–309
organizing layers for animation, 307
outlining type, 299–300

image files
Edit Original command, 15
supported types of, 14–15

Image Preprocessor script, using with panoramic 
photos, 376

images. See also photos
animating, 338–341
balancing via Equalize effect, 170
blending together, 379
changing odd number of pixels for, 339
fixing flicker in, 340
high-resolution, 339
overlapping, 371
removing blemishes from, 383
splitting in virtual space, 328

Import As menu, options on, 34–36
Import command, keyboard shortcut, 40
importing

3D files, 224–225
3D models, 241–243
3D objects into After Effects, 246–248
artboards into After Effects, 316
assets from Premiere Pro to After Effects, 19
audio into Soundbooth, 278
clips from OnLocation projects, 20
folders, 39
footage files, 16–17
footage into After Effects, 149–150
image files, 14–15
layered sources in After Effects, 34
logos into After Effects, 109–111
from nonlinear editors, 18–19
sequences as clips, 20–21
type in Illustrator, 71–72

Indent Spacing option, 70
integration

Dynamic Link, 20–22
moving media, 23

working with footage files, 16–19
working with image files, 14–15
XLF format exchange, 22

interactive content, using Flash Professional CS5 
for, 7

intervalometers, using, 365

J
Justification settings, using with text, 67–68

K
kerning

adjusting, 63
performing quickly, 236
process of, 60–61
setting, 66

keyboard shortcuts
adding folders to Project panel, 39
adjustment layers, 134
creating line, 70
deleting files from Project panel, 40
deleting folders from Project panel, 40
Edit Original command, 15
hiding and unhiding selections, 62
Import command, 40
importing multiple files, 39
kerning by increments, 60
layer duplication, 204
levels adjustment in Photoshop, 103
merging layers, 108
moving anchor points, 77
Outlines command in Illustrator, 77
paragraph spacing values, 70
repeating transformations in Illustrator, 304–305
Replace Footage command, 41
Roto Brush tool, 174
scaling footage horizontally, 36
scaling footage vertically, 36
scaling layers, 36
selecting all images in Bridge, 148
splitting layers, 211
type conversion in Illustrator, 73

keyframes
converting audio to, 271–272
modifying velocity curves for, 340–341

keying, fixing, 168–173
Keylight effect, using, 169, 172

L
layer markers, applying for audio, 265
layer masks. See also masking layers

changing views in Photoshop, 103
for logos in Photoshop, 101–104

layer styles
rasterizing, 108
using with type, 80–82

layered documents, prepping for After Effects, 
349–350

layered sources, working with, 33–37
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layering 2D and 3D layers, 227–228
layers. See also adjustment layers; shape layers; video 

layers
changing anchor points for, 36
cloning empty, 164
duplicating, 204
fitting to compositions, 36–37
marking for logo animations, 115
merging, 108
moving around scenes, 117
renaming in Timeline, 172
sending intact to Flash, 22
splitting, 211
stretching, 36

leading
adjusting, 63
Auto setting, 68
process of, 62–63
setting, 66

Leave Color effect, 139–140
levels, fixing via Auto effects, 162
Levels effect, using to restore contrast, 154–155
light transmission, controlling, 256–257
lighting

adding to scenes, 363–364
adjusting in Photoshop, 245–246
making shadows, 255–256
modifying for 3D objects, 247
parenting in After Effects, 254
processing of, 247–248
scenes in panoramas, 391–392

lighting equipment, for Blu-ray and DVD design, 
402–403

lights, blinking, 186–188
line breaks, applying, 68–69
line composers, 68–69
lines

creating, 70
creating flowing, 296–297

Live Paint Bucket tool, using in Illustrator, 298–299
Live Photoshop 3D effect, using, 247
Live Trace command

cartoon look, 145
for logos in Illustrator, 95–97
using, 144–147

logo animation. See also animation
adjustment layers, 118–119
converting Photoshop text, 112
ECO, 119–120
hierarchy, 115–117
importing into After Effects, 109–111
interpreting alpha channels, 111–112
marking layers, 115
moving layers around scenes, 117
null objects, 117
parenting layers, 116–117
using audio for inspiration, 114–115
using Continuously Rasterize, 112–113

logo bug, keeping on top of 3D layers, 227
logo files, converting, 90

logos
animation files, 90
artboard in Illustrator, 92
color space in Illustrator, 91
color space in Photoshop, 97
creating layer masks in Photoshop, 101–104
creating versions in Illustrator, 95–97
finalizing masks in Photoshop, 105
pixel aspect ratio in Photoshop, 98–99
Release to Layers in Illustrator, 93–94
removing backgrounds in Photoshop, 99–101
removing from clothing in shots, 168
resolution in Photoshop, 98
style guides, 88–89
template layers in Illustrator, 94–95
text placement, 89
using in Photoshop DVD menu design, 424–425
using Live Trace in Illustrator, 95–97

M
Map Art button, using, 229
markers, using with audio, 263–266
mask controls, accessing quickly, 142
masking layers, 347–349. See also layer masks
Masks panel, in Photoshop for logos, 102–103
Material Options, advanced, 257–258
matte, creating from color, 170–173
matte key, using, 169–173
media

editing, 18
moving in Creative Suite, 23

media backgrounds in After Effects. See also 
backgrounds

colorizing, 420–422
creating compositions, 415–416
looping, 418–420
rendering, 422
shortening compositions, 419
stacking footage, 417–418
stretching footage, 417

Media Encoder. See Adobe Media Encoder
media management, using Bridge for, 8
memory, boosting for 3D objects, 245
menu systems, use of motion graphics in, 12
menus. See also Encore menus; footage plates for 

menus; Photoshop DVD menu design
assembling in Encore, 428–431
Blu-ray formats, 416
designing for Blu-ray and DVD, 395–396, 399
Flash Interactive format, 416
NTSC formats, 416
PAL formats, 416

merged footage, replacing with layered source, 34
meshes

applying to shapes, 235
producing with curves, 235

mobile devices, designing for, 12–13
mobile phones, producing content for, 9–10
models, painting on, 236. See also 3D models
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motion
creating with After Effects, 208–212
sketching with Puppet Pin tool, 362–363

motion control 3D
Puppet tools, 360–363
vanishing point, 357–360

motion graphics
interactive uses, 11–12
traditional uses of, 11
use in menu systems, 12

Motion keyframes, converting to After Effects, 19
motion tracking versus stabilizing footage, 157
Motion values, converting to After Effects, 19
MP3 audio format, 261
MPEG formats, using, 16
music, customizing for After Effects, 8

N
noise, suppressing color in, 155. See also Fractal 

Noise effect
noise and grain, removing, 154–156
Noise gradient type, using, 138
nonlinear editors, importing from, 18–19
NTSC formats, using with menus, 416
null objects, using with logo animations, 117

O
Object Rotate tool, using with 3D elements, 244
objects. See also Smart Objects

cloning in After Effects, 163–167
converting to 3D, 222
expanding in Illustrator, 308–309
extruding, 229–230
separating from backgrounds, 99

Offset Path effect, using to outline type, 299–300
Offset technique

using as repeating shape, 218
using with graphic-texture animation, 201–204

On Image tool, 132–133
OnLocation CS5, 8–9, 20, 23
Opacity keyframes, converting to After Effects, 19
Opacity values, converting to After Effects, 19
OpenType fonts, 54
Orbit Camera tool, using, 360
organizing projects, using Common Media Folder, 

27–32
output options, availability in Media Encoder, 10
overexposure versus underexposure, 162

P
painting on models, 236
PAL formats, using with menus, 416
Pan Behind tool, using, 36
Panasonic P2 card, support for, 17
panning and scanning photos, 336–341
panoramic photos. See also Photomerge command

bubble level, 370
capturing shots, 374–375

in After Effects, 386–392
handheld shooting, 375–376
integrating with 3D cameras, 389–391
landscape aspect ratio, 374–375
L-plates, 370–371
Photomerge command, 376
portrait aspect ratio, 374–375
preprocessing, 376
rigs for, 369
rotating 15-degrees for, 371
shooting in portrait mode, 370
shooting techniques, 372–373
tripods, 369–371
using Image Preprocessor script with, 376
using Perspective method, 373

Paragraph panel controls
Align buttons, 66–67
hanging punctuation, 71
hyphenation, 69–70
Justification, 67–68
line composers, 68–69

paragraph spacing, setting values for, 70
paragraph type

creating, 65
resizing areas of, 65
setting in Illustrator, 73

particles, using to create depth, 365
Particular plug-in, 328
path effects, generating in After Effects, 318–322
Path Selection tool, using in Photoshop, 79
path type, creating, 65
Pathfinder, using in Illustrator, 305–306
paths

importing into After Effects, 317–318
using in Photoshop, 309

patterns. See also Cell Pattern
seamless, 201
starting at first frame, 198
using for backgrounds, 191–192
using Random Seed slider with, 195
using with graphic-texture animations, 201–204

Pen tool
auto switching, 290–291
displaying functions of, 291

Perlin noise, origins of, 198
perspective

adding, 328
stacking order, 227–228
working in 2D, 222
working in 2.5D, 223
working in 3D, 224–227

Perspective method, using with panoramic photos, 
373

photo expansion to 3D
Color Range command, 345
determining captured perspective, 341–342
making accurate selections, 343–347
masking layers, 347–349
planning shots, 343
preparing layers for After Effects, 349–350
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Quick Selection tool, 343–344
Refine Edge command, 345–347

Photo Filter adjustment, 130–131
Photomerge command. See also panoramic photos

aligning images, 379–380
choosing layout method, 377–379
cleaning up unwanted objects, 382–385
invoking from Bridge, 376–377
making seamless loop, 380–382
organizing images, 376–377
using with panoramic photos, 375

photos. See also images
animation of, 326
panning and scanning, 336–341
placing into compositions, 337
using anchor points with, 336
using animation properties with, 336
using for backgrounds, 192

photos for motion control
aspect ratio, 332–335
captured action, 335–336
Clone Stamp tool, 332–333
composition, 332–335
focus, 330–332
resolution requirements, 329–330
scanning, 331

Photoshop CS5 Extended
3D file formats, 240–241
3D Postcard, 232–233
3D shapes, 233–234
adjustment layers, 127–128
advanced cloning, 167–168
Calculations command for logos, 101–104
changing views with layer masks, 103
Character panel, 66
color space for logos, 97
creating 3D layers, 232–235
creating 3D with Repoussé, 80–82
creating alpha channels manually, 108
creating layer masks for logos, 101–104
creating Smart Objects, 125
Curves, 139
Direct Selection tool, 79
features of, 5–6
finalizing masks for logos, 105
gradient maps, 136–138
grayscale meshes, 234–235
levels adjustment for logo, 103
Masks panel for logos, 102–103
moving files in, 23
Path Selection tool, 79
pixel aspect ratio for logos, 98–99
preparing textures with, 208
presets in Adjustments panel, 128
PSD files and video layers, 128–129
Refine Mask for logos, 105–107
removing logo backgrounds, 99–101
rendering video from, 129
resolution of logos, 98
saving layered files from Illustrator, 308

setting paragraph and area type, 77–78
setting text in, 63
setting type along path, 78–79
Smart Filters, 126
storing actions in, 381
supported file formats, 125
type conversion in, 77
using batch process with, 129
using filters in, 332
vector tools in, 287–288
video layers, 123–125
viewing action safe areas in, 65
viewing title safe areas in, 65
viewing video controls, 123

Photoshop DVD menu design. See also DVD design; 
menus

adding imagery, 423–424
designing buttons, 425–428
loading reference frame, 422–423
using Smart Objects, 424
using text and logos, 424–425

Photoshop engine, location of, 128
Photoshop files, converting to 3D space, 351–352
Photoshop lighting, adjusting, 245–246
Photoshop text, converting to vector type, 112
Photoshop’s vector tools. See also vectors

Custom Shape tool, 310–311
modes, 309–310
Work Paths, 311–312

Pitch and Timing effect, using in Soundbooth, 282–283
pixel assets, converting, 98
pixels. See also fill pixels; transparent pixels

changing odd number of, 339
nonsquare, 146

placeholders
creating, 43
replacing, 42
using, 42–43

point sizes
setting for leading, 62
setting for typefaces, 55, 66

Point tools
creating anchor points, 288–289
creating corner points, 290
selecting paths and points, 289
using smooth points, 290

point type
creating, 64–65
setting in Illustrator, 73

poster frame, setting, 44
PostScript fonts, 53
Premiere Pro CS5

features of, 5
importing assets from, 19
moving files in, 23

Premiere Pro footage. See also Blu-ray design; 
DVD design

loading, 412–413
making subclips, 413
Media manage, 414–415
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preset effects, 143–144
processed looks

film-look effect, 141
power window, 142
presets, 143–144
sketched footage effect, 142

product trailer, blinking lights project, 186–188
Production Paperwork folder, using, 29
Production Premium edition

Adobe Media Encoder, 10
Adobe OnLocation CS5, 8–9
Adobe Premiere Pro CS5, 5
Bridge CS5, 8
Device Central CS5, 9–10
Encore CS5, 9
Flash Catalyst CS5, 9
Flash Professional CS5, 7
Illustrator CS5, 6
moving files within, 23
Photoshop CS5 Extended, 5–6
Soundbooth CS5, 7–8

Project Files folder, using, 28–29
Project panel

adding empty folders to, 39
deleting files and folders from, 40

projects
reducing, 18, 46
saving versions of, 44
splitting, 46

proxies, using, 43–44
PSD files, using with video layers, 128–129
punctuation, hanging, 71
Puppet tools, using, 360–363

Q
Quick Mask command, using, 348
Quick Selection tool, using, 343
QuickTime movies, generating, 129

R
Radio Waves effect, using, 196–198
RAM, managing for 3D sources, 248
RAM previews, speeding up, 339
raster graphics, using Photoshop CS5 Extended for, 

5–6
raster images, converting to vector files, 146–147
rasterization, applying continuously, 112–113
rasterizing layer styles, 108
Reduce Project command, using, 46
Refine Edge command, using, 345–347
Refine Mask, for logos in Photoshop, 105–107
Remove Grain effect, using, 154
Remove Unused Footage command, using, 45
render process, using placeholders in, 42
Render Video option, choosing in Photoshop, 129
repairing footage

controlling exposure, 162–163
quick fixes with Auto effects, 160–162
removing noise and grain, 154–156

smoothing over time, 156–157
Temporal Filtering controls, 156–157

Repeater operation, using with shapes, 217–218
Replace Footage command, using, 34, 41
Repoussé

creating 3D text, 236–239
Extrude controls, 238
extruding selections, 239–240
Inflate controls, 238
Materials controls, 238
Scene Settings, 238
using to create 3D, 80–82

Resolution menu, changing for images, 339
Resource Central, using with Soundbooth, 274–275
Revolve command, using in Illustrator, 228, 

230–231
RGB, converting CMYK documents to, 91, 97
Rotate command, avoiding, 228
rotation, stabilizing, 159
Roto Brush, using, 173–179
RotoBezier path, converting to, 291

S
sample rates, considering for audio, 262–263
saturation, cleaning up in skin tones, 162–163
scaling footage, 36
scanning and panning photos, 336–341
scanning photos, 331
scenes

adding lights to, 363–364
creating depth with particles, 365
moving layers around, 117
rotating around, 360
using footage plates, 364–365

scores
customizing for After Effects, 8
using in Soundbooth, 7, 275

Scratch Disk settings, assigning, 31
script typefaces, 59
scripts, using with panoramas, 387–389
Selection tool, using with paths and points, 289
selections

improving, 344
isolating, 345

sequence markers, converting to After Effects, 19
sequences, importing as clips, 20–21
serif typefaces, 56, 59
shadows, creating, 255–256
Shape Builder tool, using in Illustrator, 306
shape layers. See also layers

animating, 214–218
using in After Effects, 313
using in Photoshop, 309

shape libraries, creating in Illustrator, 306–307
Shape menu, adding custom shapes to, 234
shapes

applying meshes to, 235
building in Illustrator, 304–306
creating fluid, 294–296
creating in After Effects, 215
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creating variations in Illustrator, 300
modifying, 215–216
morphing in After Effects, 315–316
repeating, 217–218
saving customizations as presets, 311
storing as animation presets, 215

shared drive system, using, 28
shots. See footage
sketch look, adding to footage, 142–143
Sketch option, using with Puppet tools, 362–363
skin tones, cleaning up saturation of, 162–163
Smart Filters, using in Photoshop Extended, 126
Smart Objects. See also objects

adding textures as, 242
creating in Photoshop, 125
desaturating in DVD menu design, 424
using in DVD menu design, 424

smooth points, using, 290
sound. See audio
Soundbooth CS5. See also audio

adding filters to tracks, 281
adding to workflow, 266
applying effects, 281–282
browsing through Scores, 275–277
changing keyframe interpolation, 281
controlling fade in and fade out, 283–284
Convolution Reverb effect, 282
displaying length of audio clips in, 279
dragging audio sources in, 281
editing audio to video, 278–279
entering durations for scores, 279
features of, 7–8
importing audio into, 278
Intensity controls, 280
keyframing variables in scores, 280
looking for effects, 281
Maximize Clip button, 280
moving files in, 23
Pitch and Timing effect, 282–283
Resource Central, 274–275
Scores in, 275–277
Synth controls, 280
Variation menu, 278
working in, 262

speed property, converting to After Effects, 19
Spiral tool, using in Illustrator, 294
Spot Healing Brush

using, 168
using with panoramic photos, 385

Star tool, using, 229
still images

creating, 139
creating proxies for footage, 44

Stock Footage folder, using, 29
storyboards, creating for logos in Illustrator, 93
Stroke effects, generating in After Effects, 318–319
SWFs, importing, 17
symbols, using for quick designs, 307

T
tapeless sources, working with, 17
Temporal Filtering controls, using, 156–157
text. See also fonts; typefaces

setting in Photoshop, 63
using in Photoshop DVD menu design, 424–425

text animator, creating, 83–85
text area, resizing in Illustrator, 71
text layer, soloing visibility of, 78
text scale, setting, 66
Text tool, using in After Effects, 83–85
textures. See also grayscale textures

adding as Smart Objects, 242
adding with brushes in Illustrator, 300–304
preparing with Photoshop, 208
using for backgrounds, 191
water, 199
wood-like, 199
wrapping to surfaces of objects, 234

Time Remapping effect
converting to After Effects, 19
using, 184
using Graph Editor with, 185–186

time-lapse shots, shooting, 364–365
Timeline layers, names of, 41
Timeline panel

navigating, 265
renaming layers in, 172
using with Clone Stamp tool, 164–165

tints, controlling, 133
Tone effect, using to create sound, 269–270
Tools panel, switching between tools in, 77
Tracker panel, displaying, 158
trackpoints, adjusting, 158–159
transform functions, repeating in Illustrator, 

304–306
transparent pixels, selecting, 108. See also pixels
TransType tool, features of, 53
TrueType fonts, 53
Turbulent Noise effect, 199
type

adding dimension to, 81
converting to outlines in Illustrator, 76–77
customizing with Illustrator, 76–77
in After Effects, 83–85
entering, 64–65
importing in Illustrator, 71–72
outlining with Offset Path effect, 299–300
setting color for, 66
setting for video, 65
specifying along path in Illustrator, 74–76
specifying rows and columns, 73
using layer styles with, 80–82
varieties of, 64
wrapping around objects, 74–76

type layout
hiding and unhiding selections, 62
kerning, 60–61
leading, 62–63
tracking, 61–62
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type on path
setting in After Effects, 85
setting in Illustrator, 74–76
setting in Photoshop, 78–79

type orientation, switching in Illustrator, 73
typefaces. See also Character panel; fonts; text

categories, 58–60
font families, 57–58
versus fonts, 54–56, 58
script, 59
selecting, 57
serifs, 59

typographic controls, availability in Illustrator, 63. 
See also font technology

U
underexposure versus overexposure, 162

V
Vanishing Point Exchange, using, 328, 357–360
vector documents

creating Illustrator files, 292–293
designing with multiple artboards, 293–294

vector files, converting raster images to, 146–147
vector graphics

scaling without pixelation, 112–113
using Illustrator CS5 for, 6

vector lines, using Revolve command with, 230–231
vector Shape tools, using, 310
vector shapes

copying and pasting, 228
importing into After Effects, 317–318
using for backgrounds, 192

vector tools
in After Effects, 288
in Flash, 288
in Illustrator, 287
Pen and Point, 288–291
in Photoshop, 287–288

vector type, converting Photoshop text to, 112
vectors, converting footage to, 144–150. See also 

After Effects vector elements; Illustrator’s vector 
tools; Photoshop’s vector tools

vectorscopes, availability in OnLocation, 9
Vegas effects, generating in After Effects, 320
velocity curves, modifying for keyframes, 340–341
video

deinterlacing, 129
rendering from Photoshop, 129
using Adobe Premiere Pro CS5 for, 5

video editors, working with, 262
video effects, converting to After Effects, 19

video layers. See also layers
processing with Photoshop Extended, 123–125
using PSD files with, 128–129

video projects, using OnLocation during planning, 8
video transitions, converting to After Effects, 19
viewers, splitting to, 164
views, resetting in After Effects, 222
Volume audio filters, converting to After Effects, 19
volumetric light, using, 363
VU meter, viewing measurements in, 265

W
water textures, creating, 199
WAV (Windows Waveform) audio format, 261
wave pattern

creating, 196–198
creating seamless, 198

waveforms
availability in OnLocation, 9
using to line up markers, 265

websites
3D models, 243
3D Warehouse, 243
Archive 3D, 243
Brands of the World, 90
expressions for audio, 273
importing 3D files, 224
Infiniti Board, 401
Kaidan, 371
logos, 90
Map Art, 229
OpenType fonts, 54
Really Right Stuff, 370
Soundbooth, 8
time-lapse movies, 365
TurboSquid, 243
type styles, 56
Vuemore, 401

wood-like textures, creating, 199
Work Paths, using in Photoshop, 311–312
workflow, improving with Creative Suite, 10–13

X
XFL format, using, 22
x-heights, setting for typefaces, 55

Y
YouNeverKnow.aep project, opening, 84

Z
Zoom controls, using with 3D elements, 244
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